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Lesson 01
Creating a Basic 3D Surface Model
Elevation & Thickness

To work in three dimensions in AutoCAD, we need to use a third axis on the rectangular
(Cartesian coordinate system. This axis (defined as Z), determines the depth of an object. In
this context, the X-axis will identify the WIDTH, the Y-axis LENGTH and the Z-axis
determines the DEPTH of an object.

1. Start a new file from scratch. Accept all the default settings.

! Create New Drawing 2=l

& Start from Scratch

ERles

r— Default Setting:

{* English [feet and inches]

 Metic

—Tip
Uses the default Englizh (feet and inches] settings.

()8 I Cancel |

2. Turn the Grid and Snap ON (F7 & F9), and use the default spacing.

Command: grid <Enter>

Specify grid spacing(X) or [ON/OFF/Snap/Major/aDaptive/Limits/Follow/Aspect]
<0.5000>: L <Enter>

Display grid beyond Limits [Yes/No] <Yes>: n <Enter>

Command: <Enter>

Specify grid spacing(X) or [ON/OFF/Snap/Major/aDaptive/Limits/Follow/Aspect]
<0.5000>: d <Enter>

Turn adaptive behavior on [Yes/No] <Yes>: n <Enter>

Command: <Enter>

GRID

Specify grid spacing(X) or [ON/OFF/Snap/Major/aDaptive/Limits/Follow/Aspect]
<0.5000>: .5 <Enter>

{Press F7 to turn the grid ON}

Command: <Grid on>

Command: z <Enter>

ZOOM

Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window] <real time>: a <Enter>

3. Create a new layer named object, assign the color green to it, and make it the current
layer.
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4. Enter the ELEV Command and set the new default elevation at 1” and the new
default thickness at 3.

Command: elev <Enter>
Specify new default elevation <0.0000>: 1 <Enter>
Specify new default thickness <0.0000>: 3 <Enter>

5. Begin you drawing with the LINE Command, and construct the figure 1.
Do not be concern about the exact sizes. Keep your drawing proportional to one
shown in Figure 1.

6. Usethe VPOINT and setitto SE Isometric.

Command: vpoint <Enter>

Current view direction: VIEWDIR=0.0000,0.0000,1.0000

Specify a view point or [Rotate] <display compass and tripod>: 1,-1,1 <Enter>
Regenerating model.

—_— —

. Yiewpoint Presets, ..
You may access this command from

e i Create Camera Yiewpaoint
View” pull down menu. , ,
. ] Flan View
Show Annakakive Objecks r
(Figure 2) & ) Top
P Hide
) @ Bottam
Yisual Skyles r ﬂ F
Left
Render ’ =
) . () right
@ Motion Path Animations. ..
@ Eront
Display * g Back,
Toolbars., ..
@ SW Isometric
\’ SE Isomekric
@ ME Isometric
@3 Mt Tsometric
Figure 2

Your drawing in SE Isometric will look similar to one shown in figure 3.

7. Changing the Elevation and Thickness

Command: elev <Enter>
Specify new default elevation <1.0000>: -1 <Enter>
Specify new default thickness <3.0000>: 6 <Enter>
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Figure1 PLAN VIEW B >< o
Figure 3 3D View

8. Add a circle as shown on Figure 4 and view from SE Isometric. (Figure 5)

LN
f NN

b x

Figure 4

Figure 5

8. From the “View” Pull Down menu ,
select “Hide”, or enter the HIDE
command from the keyboard.

.".X::::'-.'::::Figﬁ
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Construct a 3D solid model using Thickness and elevation change. (Figure 1-1)

+‘ ’+ 125
[.Z0D

SEE DETAIL "A” #6.50
(THICK. 3)

27"
»1.50

VROINT (1,—1,1) -

?3.50
DETAIL "A” THICH. 2,
SCALE 5 : 1 ELEY 6
24.000° [
20 X 10
CONSTRUCT 3D WIEW P((EH\TE;V?Y 0
USING THICKMESS & .
ELEVATION CHAMNGE R.75 } \(
TYP. l —f 12"

ARRAY THIS 15 TIMES

Figure 1-1
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Lesson 02
Creating Primitives
BOX

o,

% Draw menu: Modeling » Box

% Modeling toolbar:

EE command entry: box

% Dashboard: 30 Make panel, Box
Start a new file from scratch. Accept all the default settings.

1. Use the VPOINT and setitto SE Isometric.

'h‘J‘ ] u E’ L_s QUL 8 Dimension  Modify  Window Help  Ac
cly @'|ﬂ]1l Q SR & Madeling Lf, Palysolid
e 3 ) B
i@ @ @| i 2 A Line & wede
3/ Ray =
‘_:3 Zone

f Construction Line

2. Use the pull-down menu or the - ) Sphere
toolbar to select the desired bt U Cylinder
command. You may also type in 3 Polyiine ) Eﬂms
command line. 2 30 Palyline \ Pyramid

wr Paolygon .
1 Rectangls Planar Surface

i

Command: vpoint <Enter>

Current view direction: VIEWDIR=0.0000,0.0000,1.0000 <Enter>
Specify a view point or [Rotate] <display compass and tripod>: 1,-1,1 <Enter>
Regenerating model.

Command: box <Enter>
Specify first corner or [Center]: {Pick a point anywhere
on screen}

Specify other corner or [Cube/Length]: L <Enter> N
Specify length: 4 <Enter>
Specify width: 3 <Enter>
Specify height or [2Point]: 2 <Enter> o
A
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Lesson 03
Creating Primitives
CYLINDER & WEDGE

% Modeling toolbar: U % Modeling toolbar: B

% Draw menu: Modeling = Cylindet % Drawve menu: Modeling » Wedge
E= command entry: cylinder EE command entry: wedge
% Dazhboard: 30 Make panel, Cylinder % Dashboard: 30 Make panel, Wedge

Command: cylinder <Enter>
Specify center point of base or [3P/2P/Ttr/Elliptical]:

{Pick a point anywhere on screen} (ﬁD
Specify base radius or [Diameter]: 1 <Enter> 7 S
Specify height or [2Point/Axis endpoint] <2.0000>: 4 <Enter>

AV

|
D
£
il

Command: wedge <Enter>
Specify first corner or [Center]: <Enter>

Specify other corner or [Cube/Length]: L <Enter> Z
Specify length <3.0000>: 3 <Enter>
Specify width <4.0000>: 1 <Enter> hd
Specify height or [2Point] <2.0000>: 2 <Enter>
(68
s
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Lesson 04
Creating Primitives
CONE & FRUSTUM CONE

Creates a 3D solid with a circular or elliptical base tapering
symmetrically to a point or a circular or elliptical planar face

3

R Menu: Draw » Modeling » Cone

% Toolbar: Modeling

EE command entry: Cone
£ Dashboard: 3D Make panel, Cone

Command: _cone <Enter>

Specify center point of base or [3P/2P/Ttr/Elliptical]: 5,5 <Enter>
Specify base radius or [Diameter] 2 <Enter>

Specify height or [2Point/Axis endpoint/Top radius] <0000>: _top
Specify top radius 1 <Enter>

Specify height or [2Point/Axis endpoint] 3 <Enter>

i

~ 64,00 -
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Lesson 05
Creating Primitives

PYRAMID
© O
% Modeling = Pyramid
(= pyramid
% 3D Make panel, Pyramid
Command: pyramid <Enter> z
4 sides Circumscribed
Specify center point of base or [Edge/Sides]: M
{Pick a point anywhere on screen}
Specify base radius or [Inscribed] <1.0000>: 1 <Enter>
Specify height or [2Point/Axis endpoint/Top radius] <2.0000>: 3
<Enter> &
A
Command: pyramid <Enter>
4 sides Circumscribed i
Specify center point of base or [Edge/Sides]: S <Enter>
{Pick a point anywhere on screen}
Specify base radius or [Inscribed] <1.0000>: 2 <Enter> b
Specify height or [2Point/Axis endpoint/Top radius] <2.0000>: 5
<Enter>
(&3
A

Command: pyramid <Enter>

4 sides Circumscribed

Specify center point of base or [Edge/Sides]: s <Enter>

Enter number of sides <4>: 5 <Enter>

Specify center point of base or [Edge/Sides]:

Pick a point anywhere on screen}

Specify base radius or [Inscribed]: <Enter>

Specify height or [2Point/Axis endpoint/Top radius] <-9.2512>: t
<Enter>

Specify top radius <0.0000>: .5 <Enter>

Specify height or [2Point/Axis endpoint] <-9.2512>: 6 <Enter>
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Lesson 06

Creating Primitives
SPHERE - TORUS

I

Maodeling = Torus

/

Modeling » Sphere

sphere torus

CHED
[

3D Make panel, Torus

30 Make panel, Sphere

Command: sphere <Enter>

Specify center point or [3P/2P/Ttr]:
{Pick a point anywhere on screen}
Specify radius or [Diameter] <2.3094>: 2
<Enter>

Command: torus

Specify center point or [3P/2P/Ttr]:

{Pick a point anywhere on screen}

Specify radius or [Diameter] <3.3282>: 4
Specify tube radius or [2Point/Diameter]: 1

Command: torus

Specify center point or [3P/2P/Ttr]:
{Pick a point anywhere on screen}
Specify radius or [Diameter] <3.0000>: 4
Specify tube radius or [2Point/Diameter]
<6.0000>: 4

Command:

TORUS

Specify center point or [3P/2P/Ttr]:

{Pick a point anywhere on screen}

Specify radius or [Diameter] <4.0000>: -1

Specify tube radius or [2Point/Diameter] <2.0000>:
15

10
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Lesson 07

Creating Primitives
POLYSOLID

| 4

Modeling » Polysolid
polysolid

30 Make panel, Polysalid

BEBE

Command: polysolid <Enter>

Specify start point or [Object/Height/Width/Justify] <Object>: w
<Enter> i
Specify width <0.2500>: .4 <Enter>
Specify start point or [Object/Height/Width/Justify] <Object>: h hd
<Enter>
Specify height <4.0000>: 3 <Enter>
Specify start point or [Object/Height/Width/Justify] <Object>: a
A

{Pick a point anywhere on screen}

Specify next point or [Arc/Undo]: <Ortho on> 3 <Enter> .
Specify next point or [Arc/Undo]: 2 <Enter> Figure A
Specify next point or [Arc/Close/Undo]: 3 <Enter>

Specify next point or [Arc/Close/Undo]: ¢ (Figure A)

N
Using the POLYLINE command (PL), to create the T
figure“A”. Zl —I . | .....
[ R A
Use POLYSOLID command; select “Object’”” option to i ----- \ B -/"- S
construct Figure “C”. I T
$_____[).><.........
Grid space = 0.25 Figure B
Hlf'
.o
SN
N
A
Figure C

11
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Lesson 08
Constructing a Planar Surface

)

o)

% hodeling = Planar Surface

= planesurf

% 3D Make panel, Planar Surface
Command: _Planesurf <Enter> 7
Specify first corner or [Object] <Object>: 4,4
<Enter> o
Specify other corner: 10,10 <Enter> (Fig. A) - l

ST
Command: | <Enter> TERRRRS
LINE Specify first point: 11,11 <Enter> -
Specify next point or [Undo]: @10<90 <Enter> e A)
Specify next point or [Undo]: <Enter>
Command: o <Enter>
OFFSET
Current settings: Erase source=No Layer=Source
OFFSETGAPTYPE=0
Specify offset distance or [Through/Erase/Layer] <1.0000>: 5
<Enter> Figure A
Select object to offset or [Exit/Undo] <Exit>: {Select the line} e
Specify point on side to offset or [Exit/Multiple/Undo] <Exit>:
{select the side} e e
Use the ARC 3-point option to draw two arc as shown. )
(Figure B)
Figure B
Command: _Planesurf <Enter>
Specify first corner or [Object] <Object>: o0 <Enter>
Select objects: {select line} 1 found
Select objects: {select the line} 1 found, 2 total
Select objects: {select the arc} 1 found, 3 total
Select objects: {select the arc} 1 found, 4 total
Select objects: <Enter> _
Figure C

12
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% Modify menu: 3D Operations » Thicken
= command entry: thicken

% Dazhboard: 30 Make panel (click icon to expand), Thicken Surface

Command: thicken <Enter>

Select surfaces to thicken: {select the
figure C}1 found

Select surfaces to thicken: <Enter>
Specify thickness <0.0000>: 2 <Enter>

(Figure D) Figure D

% Modify menu: 30 Operations » Convert to Surface
[ command entry: convtosurface

% Daszhboard: 30 Make panel (click icon to expand), Convert to Surface

With the CONVTOSOLID command, you can convert the following objects into extruded
3D solids:

e Uniform-width wide polylines with thickness

e Closed, zero-width polylines with thickness

e Circles with thickness
Note You cannot use CONVTOSOLID with polylines that contain vertices with 0 width or
that contain segments of variable width.

Using the POLYLINE command, construct the figure E, and then cover it to a solid
model.

Command: PLINE <Enter>

Specify start point: 25,25 <Enter>

Current line-width is 0.0000

Specify next point or

[Arc/Halfwidth/Length/Undo/Width]:

@5<90 <Enter>

Specify next point or . .
[Arc/Close/Halfwidth/Length/Undo/Width]: ~ F1gure E Figure F

a <Enter>

Specify endpoint of arc or
[Angle/CEnter/CLose/Direction/Halfwidth/L
ine/Radius/Second pt/Undo/Width]: 1
<Enter>

Specify endpoint of arc or
[Angle/CEnter/CLose/Direction/Halfwidth/L
ine/Radius/Second pt/Undo/Width]: 2
<Enter>

Specify endpoint of arc or

13




[Angle/CEnter/CLose/Direction/Halfwidth/L
ine/Radius/Second pt/Undo/Width]: .5
<Enter>

Specify endpoint of arc or
[Angle/CEnter/CLose/Direction/Halfwidth/L
ine/Radius/Second pt/Undo/Width]: L
<Enter>

Specify next point or
[Arc/Close/Halfwidth/Length/Undo/Width]:
@5<-90 <Enter

Specify next point or
[Arc/Close/Halfwidth/Length/Undo/Width]:
c

Change the Thickness of the figure “E”
from zero to 2. {Figure F}

Command: convtosolid <Enter>
Select objects: 1 found {select the figure F}
Select objects: <Enter>

Figure G

14
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Lesson 09

Creating Composite Solids
(Boolean Operations: UNION & SUBTRACT)

Start AutoCAD and use default settings.

Command: vpoint  <Enter> then type 1, -1,1. This is the same as selecting “SE Isometric” from

the pull down menu “view™.

Command: box <Enter>

Specify corner of box or [CEnter] <0,0,0>: 4,3.5 <Enter>
Specify corner or [Cube/Length]: L <Enter>
Specify length: 3.5 <Enter>
Specify width: .5 <Enter>
Specify height: 1.5 <Enter>
Command: z <Enter>
ZOOM

Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window] <real time>: 1 <Enter>

Command: cylinder <Enter>

Current wire frame density: ISOLINES=4

Specify center point for base of cylinder or [Elliptical] <0,0,0>: 5.75,3.75,1.5
Specify radius for base of cylinder or [Diameter]: d

Specify diameter for base of cylinder: 2

Specify height of cylinder or [Center of other end]: -3

Command: cone <Enter>
Current wire frame density: ISOLINES=4

Specify center point for base of cone or [Elliptical] <0,0,0>: 5.75,3.75,1.75
Specify radius for base of cone or [Diameter]: .75 <Enter>
Specify height of cone or [Apex]: -3 <Enter>

Your drawing at this time should look like the
figure shown:

Perform the Boolean operation. {A
(cylinder) + B (box) — C (cone)}

15

<Enter>
<Enter>
<Enter>
<Enter>

<Enter>

:
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Command: union <Enter>

Select objects:  (left click on cylinder A) 1 found
Select objects: (left click on box B) 1 found, 2 total
Select objects: <Enter>

Command: subtract ~ <Enter>

Select solids and regions to subtract from . (left click on box or cylinder)
Select objects: 1 found

Select objects: <Enter>

Select solids and regions to subtract .. (left click on cone)

Select objects: 1 found

Select objects: <Enter>

Command: Hide <Enter>

Your drawing should look like the figure shown:

E aD
>

(

‘H________‘_,__r"
hide
Calculate the volume:
Mass: 9.2044
Command: massprop <Enter> Volume: 9.2044

Select objects:  (left click on the object) 1
Select objects: <Enter>

1.

16
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Exercise 9-1 Perform the Boolean operations {(A + B) - C}, and calculate the
Volume:

21,5
\ ——| 1.5 |
|c
2
n B b
—
& )
o [
|
g | I
RS
Lo G
TR
oy
| P,
l I lx l
A [ |t !

Exercise 9-2 Perform the Boolean operations {(A + B) - C}:

T D

NP7

+Hﬁ ) : R
N

.

17
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Lesson 10

Creating Composite Solids
(Boolean Operation: INTERSECT)

2. Instruction for Boolean Operation problem
Start AutoCAD and use default settings.

Command: vpoint  <Enter>
then type 1, -1,1. This is the same as selecting “SE Isometric” from the pull down menu “view”.

Select the FRONT UCS:

Command: ucs <Enter>

Current ucs name: *WORLD*

Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y[Z/ZAXis]
<World>:G <Enter>

Enter an option [Top/Bottom/Front/BAck/Left/Right]<Top>: F <Enter>

Set ORTHO to “ON” (F8), use PLOYLINE Command and draw the Front view:

Command: pl <Enter>

PLINE

Specify start point: {pick any point on screen, begin with upper left corner and draw clockwise}
Current line-width is 0.0000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: <Ortho on> 1.5 <Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 1 <Enter>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 1.13<Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 1<Enter>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 1.5<Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 2<Enter>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 4.13<Enter>

Close

Select the RIGHT UCS:

Command: ucs <Enter>

Current ucs name: *WORLD*

Specify origin of UCS or
[Face/NAmed/OBject/Previous/View/World/X/Y/[Z/ZAxis]
<World>: G<Enter>

Enter an option _
[Top/Bottom/Front/BAck/Left/Right]<Top>: R <Enter> ’

18
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Make sure the ORTHO is “ON” (F8), use PLOYLINE Command and draw the Side view

Command: pl <Enter>

PLINE

Specify start point: {pick any point on screen, begin with upper left corner and draw clockwise}
Current line-width is 0.0000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: <Ortho on> 2.25 <Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 2 <Enter>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: .5<Enter>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 1.25<Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 1.25<Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 1.25<Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: .5<Enter>

Type “c” <Enter> to Close

v

7

EXTRUDE both front and right figures, with extrusion height of extrude 2.25 and 4.13
respectively:

Command: ext <Enter>

EXTRUDE

Current wire frame density: ISOLINES=4

Select objects: 1 found {Select the front view profile)
Select objects: <Enter>

Specify height of extrusion or [Path]: 2.25 <Enter>
Specify angle of taper for extrusion <0>: <Enter>

Command: ext <Enter>

EXTRUDE

Current wire frame density: ISOLINES=4

Select objects: 1 found {Select the side view profile)
Select objects: <Enter>

Specify height of extrusion or [Path]: 4.13 <Enter>
Specify angle of taper for extrusion <0>: <Enter>

19
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B &

Move these two solid objects to the position as shown:

B

before hide after hide
USE INTERSECT COMMAND:
Command: intersect <Enter>
Select objects: 1 found {Select both solid objects)
Select objects: 1 found, 2 total
Select objects: <Enter>

%

before hide after hide

20
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EXERCISE 10-1

Raég

1. Draw this figure on the front UCS.

21

AutoCAD Workbook 3D

2. Switch to the right UCS and draw
the same figure.
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Lesson 11
Creating Helix

L
W

% Modeling toolbar

EE command entry: HELIX

% Dazhboard: 30 Make panel (click icon to expand), Helix

Construct a solid model of a spring. Create a centerline as shown on the following
figures. Use this centerline as a path to extrude a circle through.

Command: helix <Enter>

Number of turns = 3.0000 Twist=CCW

Specify center point of base: {pick a point on careen}

Specify base radius or [Diameter] <1.0000>: .5 <Enter>

Specify top radius or [Diameter] <1.0000>: .5 <Enter>

Specify helix height or [Axis endpoint/Turns/turn Height/tWist] <1.0000>:<Enter>
(Figure A)

Draw a circle with 0.125 diameter. (Figure B)

Command: _sweep <Enter>

Current wire frame density: ISOLINES=4
Select objects to sweep: {pick the circle}1
found

Select objects to sweep: <Enter>

Select sweep path or [Alignment/Base

A B  point/Scale/Twist]: {pick the helix}

22
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Lesson 12
Creating 2D Region Model

Q)

% Draw menu: Region

% Draw toolbar:

EE command entry: region

Construct the following 2D shape and 4 ¥ @00
covert it to 2D Region Model: /—

Command: _region <Enter> @ d

Select objects: 1 found {select the
square and four circles}

Select objects: 1 found, 2 total

Select objects: 1 found, 3 total

Select objects: 1 found, 4 total

Select objects: 1 found, 5 total 400
Select objects: <Enter>

5 loops extracted. @ C}

5 Regions created

—= L0

View Conceptual:

Command: _vscurrent

Enter an option
[2dwireframe/3dwireframe/3dHidden/Realistic/Conceptual/Other]
<2dwireframe>: _C

Command: subtract <Enter>

Select solids and regions to subtract from ..
Select objects: 1 found {select the square}
Select objects: <Enter>

Select solids and regions to subtract .. Calculate the area of the
Select objects: {select the four circles} 1 found region.

Select objects: 1 found, 2 total

Select objects: 1 found, 3 total

Select objects: 1 found, 4 total

Select objects: <Enter>

23
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Lesson 13
3D Coordinates
z
Command: cylinder <Enter> N
Specify center point of base or [3P/2P/Ttr/Elliptical]: 10,10 7
<Enter>

Specify base radius or [Diameter] <6.0000>: 6 <Enter>
Specify height or [2Point/Axis endpoint] <-3.0000>: .5 <Enter> =)

Command: sphere <Enter>
Specify center point or [3P/2P/Ttr]: 10,10,8 <Enter>
Specify radius or [Diameter] <6.0000>: 5 <Enter>

Command: ¢ <Enter>

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan 7

tan radius)]: 10,10,0.5 <Enter>

Specify radius of circle or [Diameter] <6.0000>:; 2 N
<Enter> "
Command: cone <Enter>

Specify center point of base or [3P/2P/Ttr/Elliptical]: —h

10,12,35 <Enter> X ©)
Specify base radius or [Diameter] <0.5000>: .5 <Enter>

Specify height or [2Point/Axis endpoint/Top radius]

<-3.0000>: -3 <Enter>

Copy the cone to each quadrant of 4”” diameter
circle. (Figure D)

Rotate each cone 15° from the vertical axis.
(figure E)

2

(D)

24
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Command: _3drotate <Enter>
Current positive angle in UCS:
ANGDIR=counterclockwise
ANGBASE=0

Select objects: {select the cone}1 found
Select objects: <Enter>

Specify base point: {snap to the
endpoint }; Figure E

Pick a rotation axis: {left click on the
green circle to rotate along Y axis}
Specify angle start point: 15 <Enter>
Regenerating model.

25
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(E)

Command: vpoint <Enter>

Current view direction: VIEWDIR=1.0000,-
1.0000,1.0000

Specify a view point or [Rotate] <display
compass and tripod>: R <enter>

Enter angle in XY plane from X axis <315>:
15 <Enter>

Enter angle from XY plane <35>: <Enter>
(Figure F)

(F)
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Lesson 14
Cylindrical Coordinates

Command: cylinder <Enter>

Specify center point of base or [3P/2P/Ttr/Elliptical]:

{select any point on screen}

Specify base radius or [Diameter] <0.5000>: 2.5 <Enter>
Specify height or [2Point/Axis endpoint] <0.0000>: -7.5 <Enter>

Command: <Enter>

CYLINDER

Specify center point of base or [3P/2P/Ttr/Elliptical]: {shap to
center of the upper cylinder}

Specify base radius or [Diameter] <2.5000>: 3 <Enter>

Specify height or [2Point/Axis endpoint] <-7.5000>: -8 <Enter>
(Figure A)

Command: ucs <Enter>

Current ucs name: *WORLD*

Specify origin of UCS or
[Face/NAmed/OBject/Previous/View/World/X/Y/Z/ZAxis]
<World>: o <Enter>

Specify new origin point <0,0,0>:

{snhap to center of the base}

Change the UCS (User Coordinate System) position from” C” to “D”’:

Command: ucs <Enter>
Current ucs name: *NO NAME*

(A)

(B)

Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y/Z/ZAxis]

<World>: n <Enter>

Specify origin of new UCS or [ZAXis/3point/OBject/Face/View/X/Y/Z] <0,0,0>: 3 <Enter>

Specify new origin point <0,0,0>: 3,0,1 <Enter>

Specify point on positive portion of X-axis <4.0000,0.0000,1.0000>: @ 3<90 <Enter>

Specify point on positive-Y portion of the UCS XY plane <2.0000,0.0000,1.0000>:

@0,0,3 <Enter>

26
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e T
< Hf’> <x¥j>
Z 4
\I/ LAl ] W
|4 57 -

Command: cylinder <Enter>

Specify center point of base or [3P/2P/Ttr/Elliptical]: 0,0 <Enter>
Specify base radius or [Diameter] <0.00>: .25<Enter>

Specify height or [2Point/Axis endpoint] <5.0000>: 2.5 <Enter>

Command: cylinder <Enter>

Specify center point of base or [3P/2P/Ttr/Elliptical]: {snap to the
center of the .25” diameter cylinder}

Specify base radius or [Diameter] <0.2500>: .125 <Enter>
Specify height or [2Point/Axis endpoint] <2.5000>: -3 <Enter> E

(Figure E)

Subtract these two cylinders to create .125 diameter
tube. {Figure F)
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Text and Dimensions in 3D

-Creating Text with Thickness
-Dimensioning in 3D

3. Exercise 14-1
Construct the following 3D solid model, add a single TEXT with default height and
thickness of .125. Complete the dimensions as shown. (Figure 1)
You need to switch the work plane as necessary, using UCS ““3point “ or “Face’ option.
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Lesson 15
Extrude

m

Modeling = Extrude

extrude

3D Make panel, Extrude

Start the AutoCAD and use the default setting.

Construct the 2D drawing as shown below to form a closed polyline.
Select the SE Isometric view.

Extrude (4”) to form the solid object.

Calculate the volume.

s

1

GRID SPACE= 0.25 = . X

Start the AutoCAD and use the default setting.
Construct the 2D polygon as shown below.

Select the SE Isometric view.

Extrude to form the solid object. Height = 4, Taper =6
0. Calculate the volume.

BoOoo~No

- Grid space = Q.25

Wireframe Hide
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EXTRUDE (path)

Construct a solid model of a bicycle handle bar. Create a centerline as shown on the following
figures. Use this centerline as a path to extrude a circle through. Three mutually perpendicular
coordinate systems are required: the WORLD, the SIDE and the FRONT. The centerline path

consists of three separate plines.

/ X . <
| 7 \x\
\\.\_// ‘%’CD “\\
’%{:} H\\
“Eoe \r/\
i | \Q__’L_
/ R
|/ 7

1. Pline with 370 length pline (arc option) or ARC with 60 radii. On each end on WCS.

3 2. Create three circles on the
X v FRONT UCS.
E‘za | 3. Create the drop portion of the

bar using the pline command
on the SIDE UCS.
4. Extrude each circle along each

- line.
X/ p
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Plot the drawing using
Shadeplot option as shown.
Make sure the color set to “gray
# 9) on your object layer.

Save your project.

EXTRUDE (path)

Construct a solid model of a spring. Create a centerline as shown on the following
figures. Use this centerline as a path to extrude a circle through. To create this path you
must use 3D polyline command and define a path with the 3D coordinate system. Easier
alternative would be using a LISP file. This file must be loaded before it can be used.
Follow the instruction below to load and use this file:

Note: In AutoCAD version 2008, you may use Helix command (lesson 11), use data on

step 8 and skip to step9.

5. From the “Tool”” pull down menu select “Load Application..”.
From the server (G: drive), student access, ““symbols-title”, under the “LISP”
folder search for the file *“Spiral”.

Load/Unload Applications

Lack i | £ LISP =l cF E- 6. Highlight “SPIRAL”,
ASCTERT DDINSERT DDSOLPRM FILTER then click on “load”
CHTEXT DOMODIFY DOLCSP MYSETUP tab

COATTDER DDOSHAR DOUMITS
DOATTEXT DOPTYPE DOVIEW
DOCHPROP DOREMAME DOYPOINT

DOGRIPS DOSELECT DLINE

4 3

File name: |SF'IFEAL
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7. From View, select SE Isometric:
8. On Command line type 3d spiral, and follow the step below:

Command: 3dspiral <Enter>

Center point: <pick a point >

Number of rotations: 5 <Enter>

Starting radius: .5 <Enter>

Horizontal growth per rotation: 0 <Enter>
Vertical growth per rotation: .75 <Enter >
Points per rotation <30>: <Enter>
Command:

Your drawing should look like the figure

A

Fiy
A

9. At this time you need to change you UCS to the FRONT view and draw a
circle with center point at one end of the path and radius of 0 .125 (See the
figure).

Command: ucs <Enter>

Current ucs name: *WORLD*

Enter an option
[New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World]
<World>: ¢ <Enter>

Enter an option [Top/Bottom/Front/BAck/Left/Right]<Top>: f
<Enter>

Command: ¢ <Enter>

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan !
radius)]: {snap to the end point of the path}

Specify radius of circle or [Diameter]: .125 <Enter>

On the FRONT UCS draw diameter 0.25 7 TR
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10. Extrude the 0.25 diameter circle along the spiral path.
11. Determine the volume and print your file. (refer to printing 3D handout)
12. Save your drawing.

Z

Exercise 15-1

Construct the 3D solid model shown on Figure 15-1

N

_’—I’--i14 23/G

| /

|

B

I i

—1 1

4

4.—%4‘——1—- %_...

] i,
R R R
iE .

[y

B —

Figure 15-1
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Tutorial Exercise 15-2

Start AutoCAD with the default settings.
Use the VPOINT Command to change the viewing option:

Command: vpoint <Enter>

Current view direction: VIEWDIR=0.0000,0.0000,1.0000

Specify a view point or [Rotate] <display compass and tripod>: 1,-1,1 <Enter>
Regenerating model.

Z

This is the same as selecting “SE Isometric” from the pull down menu “view”.
Change UCS to have XY plane to be parallel to front view:

Command: ucs <Enter>

Current ucs name: *WORLD*

Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y/Z/ZAxis]
<World>: x <Enter>

Specify rotation angle about X axis <90>: <Enter>

hr

Use POLYLINE command and draw the figure 6-1:

Command: pL <Enter>

PLINE

Specify start point:5,5 <Enter>

Current line-width is 0.0000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: @3,0 <Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @.5<90 <Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @-1,.5<Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @1,.5 <Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @.5<90 <Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @3<180 <Enter>
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Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: ¢

Figure 6-1" -~ - Figure 6-2

Command: cha

CHAMFER

(TRIM mode) Current chamfer Distl = 0.0000, Dist2 = 0.0000

Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]: d
Specify first chamfer distance <0.0000>: .5 <Enter>

Specify second chamfer distance <0.5000>: <Enter>

Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]:
{left click on line “A” Figure 6-1}

Select second line or shift-select to apply corner:

{left click on line “B”” Figure 6-1)}

Your drawing should look like the one shown in figure 6-2.

Use POLYLINE command and draw the figure 6-3:

Command: pL <Enter>

PLINE

Specify start point: 2,2 <Enter>

Current line-width is 0.0000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: @3,0

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @.5<90

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @-1,.5<Enter>
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @1,.5 <Enter>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @.5<90
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @1<180
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @.5<270
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @-1.5,-.5
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @-.5,.5
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @-.5,.5
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: ¢

Command: cha <Enter>
(TRIM mode) Current chamfer Distl = 0.5000, Dist2 = 0.5000

<Enter>

<Enter>
<Enter>

<Enter>
<Enter>
<Enter>
<Enter>
<Enter>
<Enter>
<Enter>

Select first line or [Polyline/Distance/Angle/Trim/Method]: {left click on line “A”

Figure 6-3}
Select second line: {left click on line ““B” Figure 6-3}

35




15. AutoCAD Workbook 3D

Figure 6-3 Figure 6-4
Use EXTRUDE Command to create the model:

Command: extrude <Enter>

Current wire frame density: ISOLINES=4

Select objects: { left click any place on profile Figure 6-1 } 1 found

Select objects: { left click any place on profile Figure 6-3 }1 found, 2 total
Select objects: <Enter>

Specify height of extrusion or [Path]: .5 <Enter>

Specify angle of taper for extrusion <0>: <Enter>

Use MOVE Command with help of object snap to move these models to their proper positions:

Figure 6-5
Command: m <Enter>
MOVE
Select objects: { left click any place on model “A” Figure 6-5} 1 found
Select objects: <Enter>
Specify base point or displacement: end
of {leftclick at point “1” part “A” Figure 6-5}
Specify second point of displacement or <use first point as displacement>:
end of { left click at point *“2”” part “B” Figure 6-5}

Command: hide <Enter>
Regenerating model.
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Figure 6-6 " Figure 6-7

Command: union <Enter>

Select objects: { left click on part “A” Figure 6-6} 1 found

Select objects: { left click on part “B Figure 6-6} 1 found, 2 total
Select objects: <Enter>

Your final drawing shown in figure 6-7

Use MASSPROP Command to calculate the volume.

Use TEXT Command and write the result on your final printed drawing.
Note: Refer to instruction on “Printing 3D Model™ .
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4. Tutorial Exercise 15-3
Start AutoCAD with the default settings.

Use the VPOINT Command to change the viewing option:
Command: vpoint <Enter> v

Current view direction: "
VIEWDIR=0.0000,0.0000,1.0000 7!
Specify a view point or [Rotate] <display
compass and tripod>: 1,-1,1 <Enter>
Regenerating model.

ke

This is the same as selecting “SE Isometric”
from the pull down menu ““view”.

Change UCS to have XY plane to be right side view:

ommand: ucs <Enter> Y

Current ucs name: *WORLD* -

Specify origin of UCS or X
[Face/NAmed/OBject/Previous/View/World/X/Y/Z/ZAXxis]

<World>: x <Enter>

Specify rotation angle about X axis <90>: <Enter>
Command:

UCs

Current ucs name: *NO NAME*

Specify origin of UCS or
[Face/NAmed/OBject/Previous/View/World/X/Y/Z/ZAxis]
<World>: y <Enter>

Specify rotation angle about Y axis <90>:<Enter>

Use POLYLINE command and draw the figure 6-1:

Command: pl <Enter>

PLINE

Specify start point: 5,5 <Enter>

Current line-width is 0.0000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: @1<0 <Enter>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @2<270
<Enter>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @2<180
<Enter> f
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @1<90

<Enter>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: @.5<0

<Enter> Figurel
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Command: cha <Enter>

CHAMFER

(TRIM mode) Current chamfer Dist1 = 0.0000, Dist2 = 0.0000

Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]: d
<Enter>

Specify first chamfer distance <0.0000>: .5 <Enter>

Specify second chamfer distance <0.5000>: <Enter>

Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]: i /{

{left click on line “A” Figure 6-1}

Select second line or shift-select to apply corner:

{left click on line “B” Figure 6-1)} Figure2
Your drawing should look like the one shown in figure -2.

Use POLYLINE & COPY commands and draw the figure-3:

Command: pl <Enter> !
PLINE

Specify start point: {snap to the end point 1} 3
Current line-width is 0.0000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: {snap to

the end point 2}

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: {snap to

the end point 3}

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: ¢ A
<Enter>

Figure-3

Move this profile to a new location (Figure 4) 1
3

Command: m <Enter>
MOVE
Select objects: L <Enter> 1 found
Select objects: <Enter> 2
Specify base point or [Displacement] <Displacement>: {shap to the )
end point 1}
Specify second point or <use first point as displacement>: @0,0,-1
<Enter> Figure-4

Use EXTRUDE Command, to create the model:
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Command: ext <Enter>

EXTRUDE

Current wire frame density: ISOLINES=4

Select objects to extrude: {select the profile “A*“} 1 found
Select objects to extrude: <Enter> ' h
Specify height of extrusion or [Direction/Path/Taper angle] <3.0000>:
-3 <Enter>

Command: ext <Enter>

EXTRUDE

Current wire frame density: ISOLINES=4

Select objects to extrude: {select the profile “B“} 1 found

Select objects to extrude: <Enter>

Specify height of extrusion or [Direction/Path/Taper angle] <3.0000>:
-1 <Enter> Figure 5

Command: subtract <Enter>

Select solids and regions to subtract from .. { left click on the base
part A}

Select objects: 1 found

Select objects: <Enter>

Select solids and regions to subtract ..{ left click on the small part B}
Select objects: 1 found .
Select objects: <Enter> {Figure -7} Figure 5

Command: hide <Enter>
Regenerating model.

Figure 8

Figure 7

Use MASSPROP Command to calculate the volume.

Use TEXT Command and write the result on your final printed
drawing.

Note: Refer to instruction on ““Printing 3D Model”.
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Lesson 16
Revolve Command

=
% Modeling toolbar: Il a

% Drawe menu: Modeling » Revalve

EE command entry: revolve

% Dashboard: 30 Make panel, Revalve

Draw a rectangle as shown on figure 1:

p
Command: pl <Enter>
PLINE Y
Specify start point:
Current line-width is 0.0000
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: a
A

1.5 <Enter>

Specify next point or

[Arc/Close/Halfwidth/Length/Undo/Width]: .625 <Enter> Figure 1
Specify next point or

[Arc/Close/Halfwidth/Length/Undo/Width]: 1.5 <Enter>

Specify next point or

[Arc/Close/Halfwidth/Length/Undo/Width]: ¢

Draw the line ““A” with an approximate length and
distance of 1.5 from the rectangle “B”. (Figure 2) /<
~ U

Command: revolve <Enter>

Current wire frame density: ISOLINES=4

Select objects to revolve: 1 found <
Select objects to revolve: (click on the polyline B)

Specify axis start point or define axis by [Object/X/Y/Z]

<Object>: 0 <Enter> Figure 2
Select an object: (click on the line “A” towards end; figure 2)
Specify angle of revolution or [STart angle] <360>: 90 o
<Enter> /
" /

Figure 3
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Exercise 16-1
Construct the 3D solid model shown on Figure 16-1. Use the following data & steps:

WEOINT 1,—1,1
CIRCLE Cntr 0,8 & R=1
CIRCLE Cntr 9,6 & R=1.3125
REVOLWE
(both circles 307 on ¥) 7 &
SUBTRACT:
(both circles from each other)
CIRCLE Cntr 9,6 & R=3
CIRCLE ©ntr 0,6 & R=1

CIRCLE ©ntr @2 375080 & R=.3125 ﬁ {;J
AREAY L F; 4

EXTRUDE:

(select all § circles) height= .525

SUBTRACT:

(5 circles from a 3" Rad. circle)

COFY: Ly Q.68 @
ROTATEZD: L;¥; O,0; 45
COLDR: 2
CIRCLE CME 08,625 & RK=Z2
ROTATESD: L; *; 9.0 45
COLORE: by layer
Figure 16-1

SLICE: (select pipe): Object:

{gelect vellow circle)
LIMIOM: Al
EOTATEZD ; L; =z O,0; —&0
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Lesson 17
Sweep Command

S\

% Diraw menu: Modeling » Sweep

% Modeling toolbar:

EE command entry: sweep

% Dashboard: 30 Make panel, Svweep

With the SWEEP command, you can create a new solid or surface by sweeping an open
or closed planar curve (profile) along an open or closed 2D or 3D path. SWEEP draws a
solid or surface in the shape of the specified profile along the specified path. You can
sweep more than one object, but they all must lie on the same plane

a. Sweeping the open shape profile creates a SURFACE.
Draw the figures similar to A & B (Figure 1), using ARC or POLYLINE.

Command: sweep <Enter>

Current wire frame density: ISOLINES=4

Select objects to sweep: {select the arc A} 1 found
Select objects to sweep: <Enter>

Select sweep path or [Alignment/Base

point/Scale/Twist]: {select the arc B} -
f“)}r
Figure 1

b. Sweeping the close shape profile creates a SOLID.

Using POLYGON & ARC, draw the objects similar to Figure 2

Command: sweep <Enter>

Current wire frame density: ISOLINES=4

Select objects to sweep: {select the polygon}1 found

Select objects to sweep: <Enter>

Select sweep path or [Alignment/Base point/Scale/Twist]:

{select the arc }

L5
Figure 2
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c. Sweeping the close shape profile with Twist option (Figure 3).

Command: sweep <Enter>

Current wire frame density: ISOLINES=4

Select objects to sweep: {select the profile}1 found

Select objects to sweep: <Enter>

Select sweep path or [Alignment/Base point/Scale/Twist]: T <Enter>
Enter twist angle or allow banking for a non-planar sweep path
[Bank]<0.0000>: 270 <Enter>

Select sweep path or [Alignment/Base point/Scale/Twist]:

{select the line }

(Figure 5) o A
Figure 3

d. Sweeping the close shape profile with Scale option (Figure 4).

Command: sweep <Enter>
Current wire frame density: ISOLINES=4
Select objects to sweep: {select the circle}1 found
Select objects to sweep: <Enter>
Select sweep path or
[Alignment/Base point/Scale/Twist]: S <Enter>
Enter scale factor or [Reference]<1.0000>: .25 <Enter>

Select sweep path or

[Alignment/Base point/Scale/Twist]: {select the arc} Figure 4

(Figure 5)

e. Sweeping the close shape profile with Base point option (Figure 4).

Command: sweep <Enter>

Current wire frame density: ISOLINES=4

Select objects to sweep: {select the circle}1 found
Select objects to sweep: <Enter>

Select sweep path or [Alignment/Base »c-q’ff;&%:"_
point/Scale/Twist]: B <Enter> i

Specify base point: _nod of {select the point}
Select sweep path or [Alignment/Base
point/Scale/Twist]: {select the arc}

Figure 5
(Figure 5)

.ﬂc’:;i&, %_:
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Lesson 18
Loft Command

DA

% Modeling toolbar: | ===

% Drawe menu: Modeling » Loft
B Command entry: loft

% Dazhboard: 30 Make panel, Loft

With the LOFT command, you can create a new solid or surface by specifying a series of
cross sections. The cross sections define the profile (shape) of the resulting solid or
surface. Cross sections (generally, curves or lines) can be open (for example, an arc) or
closed (for example, a circle). LOFT draws a solid or surface in the space between the
cross sections. You must specify at least two cross sections when you use the LOFT
command.

a. Controlling the Loft with Cross Sections:

Command: ¢ <Enter>

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan
radius)]:

Specify radius of circle or [Diameter] <1.5000>: 1.5 <Enter>
Command:

CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan
radius)]: @0,0,3 <Enter>

Specify radius of circle or [Diameter] <1.5000>: .5 <Enter> (1)
Command: polygon <Enter>

Enter number of sides <4>: 5 <Enter>

Specify center of polygon or [Edge]: @0,0,2 <Enter>

Enter an option [Inscribed in circle/Circumscribed about circle]
<I>: <Enter>

Specify radius of circle: 1 <Enter> (Figure 1)

)
Command: loft <Enter>

Select cross-sections in lofting order: Specify opposite corner:
Select cross-sections in lofting order:

{select the large circle} 1 found

Select cross-sections in lofting order: {select the large circle}
1 found, 2 total

Select cross-sections in lofting order: {select the large circle}
1 found, 3 total

Select cross-sections in lofting order: <Enter>

Enter an option [Guides/Path/Cross-sections only]
<Cross-sections only>: <Enter> (Figure 2)

& =)0

3)
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b. Controlling the Loft with Guide Curves:

Command: loft <Enter>

Select cross-sections in lofting order: {select the circle}1 found
Select cross-sections in lofting order: {select the circle}

1 found, 2 total

Select cross-sections in lofting order: <Enter>

Enter an option [Guides/Path/Cross-sections only] <Cross-sections
only>: g <Enter>

Select guide curves: {select the curve}1 found

Select guide curves: {select the curve}1 found, 2 total

Select guide curves: {select the curve}1 found, 3 total

Select guide curves: {select the curve}l found, 4 total (@)
Select guide curves: {select the curve}1 found, 5 total

Select guide curves: <Enter>

C. Controlling the Loft with a Path:
Draw the Figure 5, using the Helix for the path with an approximate size. Use the
Circle, Polygon, and Point command to draw cross-sections for the loft. Make sure
the path curve is intersecting with all the cross-section objects.

Command: loft <Enter>

Select cross-sections in lofting order: {select the end circle}1 found
Select cross-sections in lofting order: {select the end circle}1 found, 2
total

Select cross-sections in lofting order: {select the square}1 found, 3 total
Select cross-sections in lofting order: {select the large circle in the
middle}1 found, 4 total

Select cross-sections in lofting order: {select the small circle}1 found, 5
total 5)
Select cross-sections in lofting order: <Enter>

Enter an option [Guides/Path/Cross-sections only] <Cross-sections
only>: p <Enter>

Select path curve:{select the helix}
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Lesson 19
3dalign Command

]
% Modeling toolbar .ﬁ“

% Modify menu: 3D Operations » 3D Align

= command entry: 3dalign

You can specify either one, two or three points for the source object. Then, you can
specify one, two, or three points for the destination. The selected object is moved and
rotated so that the base points, and the X and Y axes of the source and destination align in
3D space. 3DALIGN works with dynamic UCS (DUCS), so you can dynamically drag
the selected objects and align them with the face of a solid object.

Command: 3dalign <Enter>

Select objects: {select box A}1 found

Select objects: <Enter>

Specify source plane and orientation ...

Specify base point or [Copy]: {pick endpoint 1}

Specify second point or [Continue] <C>: {pick endpoint 2}
Specify third point or [Continue] <C>: <Enter>

Specify destination plane and orientation ...

Specify first destination point: {pick endpoint 5}

Specify second destination point or [eXit] <X>: {pick endpoint 6}
Specify third destination point or [eXit] <X>: <Enter>
Command: <Enter>

3DALIGN

Select objects: {select the wedge B}1 found

Select objects: <Enter>

Specify source plane and orientation ...

Specify base point or [Copy]: {pick endpoint 3}

Specify second point or [Continue] <C>: {pick endpoint 4}
Specify third point or [Continue] <C>: <Enter>

Specify destination plane and orientation ...

Specify first destination point: {pick endpoint 7}

Specify second destination point or [eXit] <X>: {pick endpoint 8}
Specify third destination point or [eXit] <X>: <Enter>

(Figure D)
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Lesson 20
Mirror3D- 3dAarray

a. Draw a box and a wedge with an approximate
size as shown in figure 1.

Command: _mirror3d <Enter>

Select objects: {select the wedge>1 found

Select objects: <Enter>

Specify first point of mirror plane (3 points) or
[Object/Last/Zaxis/View/XY /Y Z/ZX/3points] <3points>:
<Enter>

Specify first point on mirror plane: {select the modepointl1}
Specify second point on mirror plane: {select the modepoint2}
Specify third point on mirror plane: {select the modepoint3}
Delete source objects? [Yes/No] <N>: N <Enter>

(Figure 2)

b. Create two boxes A & B and move to the position
as shown in figure C. (you may use the 3dalign or
move command).

c. Use the array or copy command to construct the
figure D.

d. Use 3DARRAY to create the figure E.

Note: Use SE Isometric view

Command: BOX <Enter>

Specify first corner or [Center]: {pick a point onscreen}
Specify other corner or [Cube/Length]: L <Enter>
Specify length: <Ortho on> 4 <Enter>

Specify width: 2 <Enter>

Specify height or [2Point] <4.1326>: .25 <Enter>

Command: _box <Enter>

Specify first corner or [Center]: {pick a point onscreen}
Specify other corner or [Cube/Length]: L <Enter>
Specify length <4.0000>: <Ortho on> .25 <Enter>
Specify width <2.0000>: .25 <Enter>

Specify height or [2Point] <-0.2500>: 2 <Enter>

Command: 3darray <Enter>
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Exercise 20-1

Use the 3DARRAY (polar option), to create the

model shown. Use your own dimensions

proportion to this figure.

Select objects: 1 found {select all the boxes}
Select objects: 1 found, 2 total

Select objects: 1 found, 3 total

Select objects: 1 found, 4 total

Select objects: 1 found, 5 total

Select objects: <Enter>

Enter the type of array [Rectangular/Polar] <R>: R <Enter>
Enter the number of rows (---) <1>: <Enter>

Enter the number of columns (|||) <1>: <Enter>

Enter the number of levels (...) <1>: 4 <Enter>

Specify the distance between levels (...): 2 <Enter>
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Lesson 21
Fillet- Chamfer

%IVIO(IH_'-«'IOOIIMI: i %h‘lodﬁytoollml: i

% Modify menu: Fillet % Modify menu: Chamfer

EE command entry: fillet [ - ommand entry: chamfer

Construct a solid model shown in figure A with an approximate size. (2 boxes with union)

Command: f <Enter>

Current settings: Mode = TRIM, Radius = 0.0000
Select first object or [Undo/Polyline/Radius/Trim/Multiple]:
Enter fillet radius <0.0000>: .25 <Enter>

Select an edge or [Chain/Radius]:

{select all the edges as highlighted in figure B}
Select an edge or [Chain/Radius]:

Select an edge or [Chain/Radius]:

Select an edge or [Chain/Radius]:

Select an edge or [Chain/Radius]:

Select an edge or [Chain/Radius]:

Select an edge or [Chain/Radius]:

Select an edge or [Chain/Radius]:

Select an edge or [Chain/Radius]:

Select an edge or [Chain/Radius]:

10 edge(s) selected for fillet.

Command: cha <Enter>

(TRIM mode) Current chamfer Distl = 0.0000, Dist2 = 0.0000

Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]:

Base surface selection...

Specify base surface chamfer distance <0.0000>: .5

Specify other surface chamfer distance <0.0000>: .5

Select an edge or [Loop]: Select an edge or [Loop]: Select an edge or
[Loop]:

C pq b )
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Exercise 21-1
Construct a solid model of this figure, using the dimensions given on the orthographic
views.{Hint: Draw the front view and extrude}

4,500
3.500 00—

| | 4375
T T -

| | 1,250
__ 1 [ 1]

2% 9,437

272K 407 CHAMFER

2,500
2 HOLES, IN LINE
= 75O e e THO e 695 |-
R1.375
—] 1000 [
i | 1000 |e 2500 ]
500 ‘ 1.813 +

| | * | | * [T
1IN 687 il 500 L]
| | r | | T | |

le— 1,375 1.563
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Lesson 22
Slice Command
3D Operations = Slice

slice

[l F IR

3D Make panel (click icon to expand), Slice

1. Draw a cone with the following specifications:

Command: cone <Enter>

Specify center point of base or [3P/2P/Ttr/Elliptical]:

Specify base radius or [Diameter]: d <Enter>

Specify diameter: 38 <Enter>

Specify height or [2Point/Axis endpoint/Top radius]: 50 <Enter>
(Figure 1)

2. Change the UCS to the front view and set the
color to green and draw the following
construction lines:

Line “A” is exactly 33 mm, line “B”” is a horizontal

line with an approximate length, line ““C*” is connected

from the quadrant of the base to the vertex of the cone
and line “D” is 30°, begins from the intersection of

two lines with approximate length. (Figure 2)

3. Use the COPY Command to copy the line “D”
to both sides with the approximate distances as
shown in figure 3.

Figure 3
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4. Use the SLICE Command with the *“3 points™ option:

Command: slice <Enter>

3
Select objects to slice:  {select the cone}1 found
Select objects to slice: <Enter> 1
Specify start point of slicing plane or [planar
Object/Surface/Zaxis/View/XY/Y ZIZX/3points] <3points>:
<Enter>
Specify first point on plane: {pick the endpoint 1}
(Figure 4)
Specify second point on plane: {pick the endpoint 2} .
Specify third point on plane: {pick the endpoint 3}

Specify a point on desired side or [keep Both sides]
<Both>: {pick the center of the base circle}

Figure 4
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Exercise 22-1_ (Adjusting Guide)
Use the VPOINT Command to change the viewing option:

Command: vpoint <Enter> =

Current view direction: VIEWDIR=0.0000,0.0000,1.0000

Specify a view point or [Rotate] <display compass and tripod>: 1,- g
1,1 <Enter> 5
Regenerating model.

This is the same as selecting ““SE Isometric” from the pull down
menu “view”.

Command: BOX <Enter>

Specify corner of box or [CEnter] <0,0,0>: {pick any point
on screen}

Specify corner or [Cube/Length]: L <Enter>

Specify length: 110 <Enter> (turn the Ortho On and place
the mouse on the positive X direction)

Specify width: 20 <Enter>

Specify height: 20 <Enter> i
Command: Z <Enter>
ZOOM
Specify corner of window, enter a scale factor (nX or nXP),
or Lo
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object X
] <real time>: . 05 <Enter> Figurel
Command: 3DARRAY <Enter>
Select objects: 1 found {select the box you just created}
Select objects: <Enter>
Enter the type of array [Rectangular/Polar] <R>:R
Enter the number of rows (---) <1>: 3 <Enter>
Enter the number of columns (|||) <1>: <Enter>
Enter the number of levels (...) <1>: 3 <Enter>
Specify the distance between rows (---): 20 <Enter>
Specify the distance between levels (...): 20 <Enter> z
(Figure 1) v
|

Erase 3 of the boxes and use the HIDE command. Your
drawing should be similar to Figure -2 -
Use the UNION Command and select all six boxes: X

. Figure 2
Command: union <Enter> Select objects: 1 found, 4 total
Select objects: 1 found  (select the each box) Select objects: 1 found, 5 total
Select objects: 1 found, 2 total Select objects: 1 found, 6 total
Select objects: 1 found, 3 total Select objects: <Enter>
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Change the color to “red”” and draw a construction line as follows:

Command: L <Enter>

LINE Specify first point: _from Base point: {under OSNAP menu pick ““from” then click at point
1} <Offset>: @40<0 <Enter>

Specify next point or [Undo]: <Ortho off> @20<270 <Enter>

Specify next point or [Undo]: <Enter>

Command: slice <Enter>

Select objects: 1 found {select the model} |

Select objects: <Enter>

Specify first point on slicing plane by G
[Object/Zaxis/View/XY/IY ZIZX/3points]

<3points>: <Enter>

Specify first point on plane: {pick point 2} Figure 3

Specify second point on plane: {pick point 3}

Figure 3

Specify third point on plane: {pick point 4} Figure 3
Specify a point on desired side of the plane or [keep 4
Both sides]: b <Enter>

Erase the right side of the figure 4 to complete the Figure 3
project. (Figure 5) L

Figure 4
Figure 5 - (Adjusting Guide)
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Exercise 22-2

Construct a solid model of these figures:

1.25

Exercise 22-3

N

30

i 100

20
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Lesson 23
Solid Editing

% Menu: Modify » Solid Editing » Imprint Edges
EE command entry: imprint
% Dashboard: 3D Make panel, Imprint

Imprints an object on the selected solid. The object to be imprinted must intersect one or
more faces on the selected solid in order for imprinting to be successful. Imprinting is
limited to the following objects: arcs, circles, lines, 2D and 3D polylines, ellipses,
splines, regions, bodies, and 3D solids.

salid selected object selected object imprinted on
solid

Figure 1
Create the solid box, and draw an ellipse and a polygon (with the approximate sizes) as shown in
Figure 2.

Command: _imprint

Select a 3D solid:

Select an object to imprint:

Delete the source object [Yes/No] <N>: y <Enter>
Select an object to imprint:

Delete the source object [Yes/No] <N>:y <Enter>
Select an object to imprint: <Enter>

Figure 2

Command: _solidedit

Solids editing automatic checking: SOLIDCHECK=1

Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: face

Enter a face editing option
[Extrude/Move/Rotate/Offset/Taper/Delete/Copy/coLor/mAterial/Undo/eXit]
<eXit>:

_extrude

Select faces or [Undo/Remove/ALL]: {pick the top face figure 3} 2 faces found.
Select faces or [Undo/Remove/ALL]: R <Enter>

Remove faces or [Undo/Add/ALL]: {pick the top face figure 3} 2 faces found, 1

Remaove faces or B2

Figure 3
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removed.

Remove faces or [Undo/Add/ALL]: Enter>

Specify height of extrusion or [Path]: -3 <Enter>

Specify angle of taper for extrusion <0>: <Enter>

Solid validation started.

Solid validation completed.

Enter a face editing option
[Extrude/Move/Rotate/Offset/Taper/Delete/Copy/coLor/mAterial/Undo/eXit]
<eXit>:

X

Solids editing automatic checking: SOLIDCHECK=1

Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: X
Solids editing automatic checking: SOLIDCHECK=1 Figure 4
Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: X

) Shel SHELL

Shelling creates a hollow, thin wall with a specified thickness. You can specify a constant
wall thickness for all the faces. You can also exclude faces from the shell by selecting
them. A 3D solid can have only one shell. New faces are created by offsetting existing
ones outside their original positions.

Select a 3D solid: Select an object

Remove faces or [Undo/Add]: Select one or more faces or enter an option

The descriptions of the Undo, Remove, Add, and All options match the descriptions of the
corresponding options under Extrude. After you select faces or enter an option, the following

prompt is displayed:

Remove faces or [Undo/Add/ALL]: Select a face (1), enter an option, or press ENTER. Enter the
shell offset distance: Specify a distance

face selected shell offset=0.5 shell offset=-0.5

Specifying a positive value creates a shell to the inside perimeter of the solid; specifying
a negative value creates a shell to the outside perimeter of the solid.
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“Modify “Pull Down menu> Solid Editing> Shell:

Command: _solidedit <Enter>

Solids editing automatic checking: SOLIDCHECK=1

Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: body
Enter a body editing option

[Imprint/seParate solids/Shell/cLean/Check/Undo/eXit] <eXit>: _shell
Select a 3D solid:

Remove faces or [Undo/Add/ALL]: 2 faces found, 2 removed.

{Remove the desired faces as illustrated in the following figures:}

Remove faces or [Undo/Add/ALL]: 2 faces found, 1 removed.

Remove faces or [Undo/Add/ALL]:

Enter the shell offset distance: .25 <Enter>

Solid validation started.

Solid validation completed.

Enter a body editing option

[Imprint/seParate solids/Shell/cLean/Check/Undo/eXit] <eXit>: X <Enter>
Solids editing automatic checking: SOLIDCHECK=1

Enter a solids editing option [Face/Edge/Body/Undo/eXit] <eXit>: X <Enter>

Remove faces or B3

- ERaE R !
- - — '
" T s . ]
COE -
< - -
T -
- -7
- .
- -

Remove Faces or E1
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EXERCISE 23-1

=

Draw a solid box using the dimension shown in Figure 23-1

2. On the top surface, locate a single 1.0 diameter circle and copy or array the circle to
other locations shown.

Use the Imprint option to imprint the circles onto the solid box. Delete the source object.
4. Extrude the imprinted circles to create three countersink holes as shown in Figure 23-3.
(NOTE: If you pick the inside the circles, only the circle are selected and highlighted. In
either case be sure to remove the top face, or any other faces if selected. (Figure 23-2)
Extrusion height = -.25 & Taper angle =35°

w

23-2

23-1

Select faces or E3

23-4

23-3

5. Extrude the small diameter of the three tapered
holes so they intersect the bottom of the solid
box. Select the holes by picking the inside of the
small holes (figure 23-4). Use the negative 23.5
value larger than thickness of the solid box, for
the height of the extrusion. (ex. —2)
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g7 Copy faces Coping Faces
“Modify “Pull Down menu> Solid Editing> Copy Faces:

Copies face as a region or a body. If you specify two points, SOLIDEDIT uses the first
point as a base point and places a single copy relative to the base point. If you specify a
single point (usually entered as a coordinate) and then press ENTER, SOLIDEDIT uses
the coordinate as the new location.

Select faces or [Undo/Remove]: Select one or more faces
The descriptions of the Undo, Remove, Add, and All options match the descriptions of the
corresponding options under Extrude. After you select faces or enter an option, the

following prompt is displayed:

Select faces or [Undo/Remove/ALL]: Select one or more faces (1), enter an option, or
press ENTER

Specify a base point or displacement: Specify a base point (2)

Specify a second point of displacement: Specify a point (3)

face selected base point and second
point selected
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Lesson 24
Creating Section Planes

Section objects have three states: Section Plane, Section Boundary, and Section VVolume.
Depending on the state you choose, you can view the cutting plane as a 2D plane, a 2D
box, or a 3D box. Grips allow you to make adjustments to the length, width, and height of
the cutting area.

) N ¢

=ection Plane =ection Boundary  Section Volume
state state state

« Section Plane. The section line and transparent section plane indicator display.
The cutting plane extends infinitely in all directions.

« Section Boundary. A 2D box shows the XY extents of the cutting plane. The
cutting plane along the Z axis extends infinitely.

« Section Volume. A 3D box shows the extents of the cutting plane in all directions.

a. Face Option

Construct the figure “A” to an approximate size. Use SECTION PLANE Command to create
figure “B”.

Command: sectionplane <Enter>
Select face or any point to locate section line or [Draw section/Orthographic]: {select the
face}

(A) (B)
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b. Two- Points Option

Construct a 3D solid model of the given views. Use the SECTION PLANE command to create a
full-section model as shown.

@1.00
2w, 50
ZxR.B0
2.00
¢ |
‘ ] *
I |
| | S0
I I ]
Command: sectionplane <Enter> -
Select face or any point to locate section line or [Draw ( )
section/Orthographic]: D <Enter>
By =1

Specify start point: {select the center of the small
circle on the left}

Specify next point: {select the center of the small
circle on the right} Figure 1.

Specify next point or ENTER to complete: <Enter>
Specify point in direction of section view:

{select a point on the opposite side of the section
object, using object snap if necessary}

Figure “2”

Figure 1
Note:
Select the section plane and right-click to turn on the”
live sectioning™ (Figure 3). Also make sure the
section plane is selected by clicking on the red
triangle on the section plane. (Figure 4)
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f;:_:‘x
( -,
""-H_\_,_,-"-’J
é Erase h"-x,q__“"—:f
'&' Mo E,c:::\t{ ".,z"
C& Copy Selection ) \
K i
O Rotate ﬁw
Draw Crder r

Activate live seckioning

Figure 2

Live section settings...

Figure 3

v Section Plane
Section Boundary

Section Yalume

Figure 4
Exercise 24-1
@2, 380
START AT

2 ¥ 2890555

GROOVE 19 X .19
1130 A prbpt e Hﬁ !
ezt P 2774 850 | |

| |
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c. Multiple Points Option

AutoCAD Workbook 3D

Construct a 3D solid model of the figure below. Use the SECTION PLANE command to

create a Half-section model as shown

I

13,

M.

o

RN

Command: sectionplane <Enter>

Lomg Sumoort

Select face or any point to locate section line

or [Draw section/Orthographic]: D <Enter>
Specify start point: {select point p1}
Specify next point: {select point p2}
Specify next point or ENTER to complete:
{select point p3}

Specify next point or ENTER to complete:
<Enter>

Specify point in direction of section view:
{select point p4}

(Use object snap as needed)
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d. Adding Jogs to a Section  (Offset Section)

B command entry: jogsection

Select section object: Select a section object Specify a point on the section line to add
jog: Pick a point on the section line

A jog is created on the section line. The jogged segment is created at a 90-degree angle
to the section line

a. Draw a section plane from mid point

. GRID. & SNaR = 025 . .
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B b. Select the section line and right-click to add jog to section.
Make sure the section plane is also checked.

The Nearest object snap is turned on to ensure you pick the line.
It is not critical that you pick the exact location on the line. Grips
allow you adjust the section plane location later. (Figure B)

Activate live sectioning

’)\ \ Live section settings. ..
. Generate 2030 section. ..
v Section Plane

Section Boundary

Section Yolume Deselect Al
u I"-\.HLLILLP -
- -

Add jog ko section

Drraw Order

Ackivate live sectioning

Shiow cut-away geomekry

Live section setkings. ..

Generake 20030 seckion, ..

EXERCISE 24-2

Create an offset sectional model of the figure below:

N
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Lesson 25
FLATSHOT Command

EE command entry: flatshot

% Dashlboard: 30 Make panel, Flatshot

With the FLATSHOT command, you can
create a flattened view of all the 3D solids
and regions in the current view.

The resulting view is a block that is a
flattened representation of the 3D model
and is projected onto the XY plane. The
process is similar to taking a ““snapshot’ of
the entire 3D model with a camera and
then laying the photograph flat. After
inserting the block, it can be modified
because the flattened view is comprised of
2D geometry. This feature is particularly
useful for creating technical illustrations

EXERCISE_ open any of your 3D model
drawing and practice with command.

Try to use the” Exports to a file option”,
and then open this file and explore!

Flatshot

Destination

() Replace existing block

ki

() Export ko a file

Foreground lines
Colar: M EElock w

Linetype:

Conkinuous A

Chscured lines

[+] Show
Colar: M EvElock w
Linetype:
a1 Conkinuaus W
_reate l [ Cancel ] [ Help
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Lesson 26
Creating and Using Multiview Layouts
SOLVIEW & SOLDRAW Commands

£ Menu: Draw » Modeling » Setup » View
EE command entry: solview
% Menu: Draw » Modeling » Setup » Drawing

EE Command entry: soldraw

Construct the following 3D Model, and then generate a 2D orthographic view using the
steps outlined below: Do not add dimension to the model view. Dimensioning will be
done on the orthographic views.

2x R.50

Steps to generate orthographic views from a 3D Model

Note: After completing your model, make sure to save your work before continuing on the
following steps:

Command: ucs <Enter>

Current UCS name: *WORLD*
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World]
<World>: V<Enter>
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Command: <Enter>
ucCs
Current ucs name: *WORLD*
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World]
<World>:S <Enter>
Enter name to save current UCS or [?]:1SO <Enter>
Go back to UCS default position (World) by pressing <Enter> twice:
Command: <Enter>
Enter an option [New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World]
<World>: <Enter>

Make sure your model relation to the user coordinate system
is similar to the figure 1.

From the “Pull-Down Menu’” Insert>Layout > Layout from,
brows through tha CAD lab server insert “Mytemplate.dwt”

file.
Z
.
3 B | Mew Layaout kx
i ] Layout From Template. ..
30 Studia. ..
] Create Layout Wizard
ACI5 File,.. : .
Figure 1
Figure 2

Bl Select Template From File

L i | ) Symbals-titles v | @ @ X views v Toods v
Preview
Marne = Siz
[ Architectural Symbals
[CIcaD 5vM
[ Dimension
() Elec-5ymbals
ShLise
[CIMECH-5¥M
IEJPiping
[ Solid-Wworks
[C2) Tutorial-handouts
[P AMSI B -Named Plat Styles.dwt g4k
[0 ArisT B, et 35k
[P AMSI_B Title, chwit 4ok
[P Architectural_D-HC, dvik g6k
i MyTemplate. dwt 67k
< | >
B ane, | tuT emplate. dwt 3 | B
Files of type: | Crawing Template [F.dwt] vl
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Select the ““Layout3 tab- w
Layoutl” tab. (Figure 3)

H—= X

4 ¢ M Y Model § Layout! § Layout2 § Lapout3-Layourd  f
0§90, 0.0000 SMAP| GRID| ORTHO POLAR [0S
Figure 3

Command: solview <Enter>
Enter an option [Ucs/Ortho/Auxiliary/Section]: u (for ucs) <Enter>
Enter an option [Named/World/?/Current] <Current>:  <Enter>

Enter view scale <1.0000>: <Enter>

Specify view center: {pick approximate point for the center of the top view, continue until the
view is in a desired location} < Enter>

Specify first corner of viewport: {pick approximate point on the upper left corner of the top view
(point A)}

Specify opposite corner of viewport: {pick approximate point on the lower right corner of the top
view (point B)} Figure 5.

Figure 5
I
Fa
e
E
Enter view name: top <Enter>
UCSVIEW =1 UCS will be saved with view
Enter an option [Ucs/Ortho/Auxiliary/Section]: O <Enter>

Specify side of viewport to project: {pick a point on the lower portion of the rectangle port.}
Specify view center: {pick approximate point for the center of the front view} <Enter>
Specify first corner of viewport: {pick approximate point on the upper left corner of the front
view}

Specify opposite corner of viewport: {pick approximate point on the lower right corner of the
front view}

Enter view name: front <Enter>

UCSVIEW =1 UCS will be saved with view

Enter an option [Ucs/Ortho/Auxiliary/Section]: O <Enter>

{Repeat the above steps to create a side view}

Specify side of viewport to project: (Pick a point on the right side of the front rectangle)
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Specify view center: {pick approximate point for the center of the side view,continue until the
view is ina desired location then press the <Enter> key}

Specify view center <specify viewport>:{pick a point on the lower portion of the rectangle port.}
<Enter>

Specify first corner of viewport: {pick approximate point on the upper left corner of the side
view}

Specify opposite corner of viewport: {pick approximate point on the lower right corner of the
side view}. Figure 6

Enter view name: side <Enter>

UCSVIEW =1 UCS will be saved with view

Enter an option [Ucs/Ortho/Auxiliary/Section]: <Enter>

Figure 4

Command: soldraw <Enter>

Select viewports to draw.

Select objects: {select anywhere on the viewports}

Select objects: {press Enter key to perform the Soldraw operation)
One solid selected.

One solid selected.

One solid selected.

Command:

Use the following steps to generate an isometric view from your 3D solid model:
Command: solview <Enter>

Regenerating layout.

Regenerating model - caching viewports.

Enter an option [Ucs/Ortho/Auxiliary/Section]:U <Enter>

Enter an option [Named/World/?/Current] <Current>: N <Enter>
Enter name of UCS to restore iso <Enter>

(Repeat all the steps above to complete the isometric view)

Before printing, freeze (or select ““no print icon on the layer dialog box) for the ISO-HID
and VPORTS layers.
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EXERCISES:

26-1 Create a solid model of the given figures. After completion, use SOLVIEW and
SOLDRAW to generate the necessary orthographic views (as shown), add dimension and
print the drawing.

Pl T
| |
-4 — -
i i 1138
- 2 % RL25 1.25 l
L N
e 413 -
' : ! 1,38 ]
#1.50 e
_ wsod—{—]
2.63
) | EX-26-1_ Shaft support
B3
3
f 1.88
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Lesson 27
Auxiliary UCS

Automatic Stop
5. Instruction

1. Draw four circles with radius of 0.50 as shown in figure 1
2. Follow the steps in figures 2 through 5 to create the profile as shown in figure 5.

o O O O

o OO O
o O o
o O O O
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@ oz
(_
oo

Fig .5 Fig.6

3. Change the view point to SE Isometric.

4. Use REGION or PEDIT to join the lines and arcs.

5. EXTRUDE the profile and four circles with -.5
extrude height. (Figure 6)

6. Subtract four small cylinders from the model.
(Figure 7)

7. Change UCS to one that shows in Figure 8 and
draw a 45 ° line.

8. Create a new auxiliary using UCS Command with
“3point” option

Command: line <Enter> Fig.7

LINE Specify first point: _mid {pick the mid point as
shown in figure 8}

Specify next point or [Undo]:

>>Enter new value for ORTHOMODE <0>:
Resuming LINE command.

Specify next point or [Undo]: @1.38<45 <Enter>

Fig.8

Command: ucs <Enter>

Current ucs name: *WORLD*

Enter an option
[New/Move/orthoGraphic/Prev/Restore/Save/Del/Apply/?/World]
<World>: n <Enter>

Specify origin of new UCS or
[ZAxis/3point/OBject/Face/View/X/Y/Z] <0,0,0>: 3 <Enter>

Specify new origin point <0,0,0>: {pick the end point 1; figure 9}
Specify point on positive portion of X-axis <-2.7475,7.5789,-
0.9901>: {pick the end point 2; figure 9}

Specify point on positive-Y portion of the UCS XY plane {pick
the end point 3; figure 9}

<-2.7475,7.5789,-0.9901>:

Fig.9
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Your drawing orientation should look like the 7
one shown in Figure 10

9. Change the view point to NE Isometric:
(Figure 11)

Command: vpoint <Enter>

*** Switching to the WCS ***

10. Current view direction: VIEWDIR=-
1.0000,1.0000,1.0000 <Enter>

Create the profile on this plane and extrude.

Command: extrude <Enter>
Current wire frame density: ISOLINES=4 ]
Select objects: 1 found {select the profile} Fig.10

Select objects: <Enter>
Specify height of extrusion or [Path]: -3 <Enter>
Specify angle of taper for extrusion <0>: <Enter>

Command: hide <Enter>
Regenerating model.

Union first then subtract the last hole.
Use the SLICE Command to remove the bottom
portion. Draw the last hole on the auxiliary plan.

Fig.11
Use SOLVIEW and SOLDRAW to generate the

necessary orthographic views including one auxiliary
view.
Note: Refer to instruction on “Printing 3D Model”

Fig.12
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Additional Problems

Construct a 3D solid model of the given orthographic views.

Problem 1

24 91.25
F1.50

G o

| |
1
}‘720{3 —
2.75

s

Problem 2

B.75
L1 1.125
¥ 18

| *, 2,30
B 75 |
| i
F.50
_|_
1 75 @, 50

r_
|
F—— 1
I
| _l_ |
|
|
—
|
L
g—
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Problem 3
Given front view of the figures below, construct the 3D solid model with 10 mm
thickness:

260 : N 75 _ -
240 \
\ W J
N !
% + 0

4

), 1
\ RS TYP.

—~| 10 I‘— THICKMESS = 10 mm

SPACER

Problem 4

Given front and right side views of the figures below, construct the 3D solid models:

T
- -
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Problem 6

Problem 7

A & W50

ECUALLY SPACED O
#2500 E.C.
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Problem 8

i

Using the AutoCAD’s modeling features, create 3D model of the given 3 views
(TOP, FRONT & RIGHT SIDE).

b. Calculate the VOLUME.
c. Generate the orthographic views as shown including an isometric view.
d. Print space scale 1=1.
-~ /\\‘\\ -
|~ #1.50 THRU ﬁ N -
|| | /-'—I_\{ IM&KE 3 \ } /ﬁ
_ _ T ;
| ] \./ 1.25 SQUD ' [
|| ! § UDELl J
| 50j— 1,75 —| 50l —] 1.00 | - g } )
500
4‘ 1.25 f=
| 1
|| [ | 1.00
- - 3.00 '
[ 91.00
+ I THRU BOTH WALLS
I | |
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Problem 9
dg
2 Zz
L.ﬁl _‘:{ 1, [
Sy £
~ e
H LQ\S f
M M\
ﬂ"ﬁe
1,13 fa
*\\2
Iy
25{' \

FILLETS & ROUNDS R ,-DE-\
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Insert your template file:

After your model is completed, from
command line or from pull-down menu
insert your template drawing as shown:

Command: layout <Enter>

Enter layout option

[Copy/Delete/New/Template/Rename/SA
veas/Set/?] <set>: t <Enter>

Locate your template file (called
“MyTemplate™ see Figure 2.)

Note: For outside of the CAD Lab, |

Printing 3D Models

Wiew | Insert Format Tools Draw  Dimension  Modify  Window Help

BECege -
I ByLayer

| % Elock...

External Reference...

Raster Image. . j

AutoCAD Workbook 3D

I

Layout

Mew Layout

ol =]
=0

Markup...

30 Studio.
ACIS File.
Drawing Exchange Binary. ..
Windows Metafile,..

OLE Object, ..

Layouk Wizard

Layaout from Template. ..

#ref Manager. ..
Image Managet,..

Hypetlink,

o CErHHE

Figure: 1

recommend that you save this file on a
diskette or go to the course web site
www.engrgraphics.pageout.net , “Course

Contents” Course Materials”

MyTemplate.dwt.

@ Select Template From File

Look. in: | [£5) Symbols-titles

Prewview

v| @ Q@ Xk Vews v Took v

Higtom

Figure 2

Marne
| Architectural Symbals
[CCAD SYM
EJDimension
| Elec-Symbols
[CLISP
[CIMECH-5YM
[C3IPiping
[ 50lid-Works
|50 Tukorial-handouts
[gansI B
[P ArST B -Mamned Plok Styles
[P0 AMST_E Title
o) Architectural_D-HC
[0 My Template
< |

Siz 8

Bk
B4k
49k
il
7k,

File name: |M.'HTE|'|'ID|~5tB

vz

Files of type: | Drawing Template [* dwt)

o] ]
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Left click “OK” tab. Click on “Layout3-Layoutl “tab

Lapout namelz];

|
Layautl Cancel
Layout? 4'
By

z
T4 p [ M\ Model § Lapoul { Lapout? I Lapout3-Lapou]
54, -4.2562, 0.0000 | SNAP| GRID| DRTHO| POLAR] 1 Figure 3

Command: <Switching to: Layout3-Layout1>
Regenerating layout.

Restore your drawing:

Command: mview <Enter>

Specify corner of viewport or
[ON/OFF/Fit/Hideplot/Lock/Object/Polygonal/Restore/2/3/4] <Fit>: R <Enter>

Enter viewport configuration name or [?] <*Active>: <Enter>

Specify first corner or [Fit] <Fit>: .5,.75 <Enter>

{NOTE: instead of typing, you may left click on the approximate points within the active
drawing area}

Specify opposite corner: 10,7.25 <Enter>

Regenerating model.

Left click on “PAPER” tab or double click any where inside the active drawing area.
Figure 4.
“PAPER” tab should switch to “MODEL”. Figure 5

| el
/
i | 3L W WL / ne K
LL Enginaaring PR souc / e
4| 4[| w|% Model £ Lapour] £ Lapout? 3 Lapout3-Layout] § v
1, 27374, 0.0000 | SNAF| GRID| ORTHO| POLAR| OSNAR|[OTRALCK LwT||PAPER
Figure 4

Scale your Drawing:

Command: z <Enter>
Z00M
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Specify corner of window, enter a scale factor (nX or nXP), or
[All/Center/Dynamic/Extents/Previous/Scale/Window] <real time>: 1xp {for 1=1 scale}

Perform Hide Plot:

| A~ Ty

| Z X

| [ _sdsu o -
Enginaaring |™* ™ [sae e

| | Model & Lapoutl 4 Layout

2} Lapout3-Lapoutl §

10000

| SMAP| GRID| DRTHO| POLAR| DSMAP[OTRACK LwT|[MODEL

Click on “MODEL” tab to switch back to “PAPER”” mode. /

Left click once on the
edge of the floating view
port to select it. Right
click to display the
short_ cut menu as
shown in Figure 6.
Select Hidden option.

Create a new layer:
Select the layer from
“Format™ pull-down
menu, or from
command:

Command: layer
<Enter>

Select the “New” tab. Figu

Mazxirize Viewpork
% Wiewpart Clip

Cisplay Yiewpork Objects »
Display Locked r

Remove Viewport Overrides For All Lavers

Shade plok

Cuk

Copy
Copy with Base Paink

&

CTRL+C
CTRL+SHIFT+C
CTRL+Y

@

Paste

(;f Erase
'*' Movwve

O% Copy Selection

Scale

Figure 6

re”.

CTRL+E | o

Figure 5

Az Displayed

\ireframe

Hidden

30 Hidden

30 Wireframe
Zonceptual
R.ealistic

Rendered
Draft

L

Mlediurmn

High
Presentation

While *“Layer1” is highlighted, click on “Freeze™ icon to turn to gray. Click on

“Current” tab.
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=341

&4 Layer Properties Manager el A

— Mamed layer filters
= [ Irwvert filker. New I Delete |
Show all layers vl | _ _
[~ &pply bo Object Properties toolbar. Current | Show detailz |
[ |I:urrent Layer. 0 Save state... | Festore state... |
| I arme | On | Freeze. .. | L... | Color | Linetype | Lineweight | Plat Style | F'Iu:u_tI_
| ] 7 4] = g white Contiruous —— Default  Caolar_7 e
Motes 7 4] = [ Green Contiruous 030 mrn Color_ 3 e
| TELE. 7 i) ' ma Contiruous — 025 mm  Color_ 8 P
| L ayer] . wihite Continuous —— Default i
Figure 7
Assign the port to Layerl: 3 File Edt ‘iew Insert Format Tools Dra
. o N HESL® 2R
Click on the edge of the floating view
port high light the layerl from the layer = & (|7 G Lm0 Bl
window and click “OK™. Smend | ¥ S ='E0 —
Figure 8: onmand | @ 8% G S WiLaer] -
smmand ;| @ O i ='0
——— O g 'l TBLK L=
x

& 1 object changed to a frozen ar off layver and

remaoved From the selection set,

G LI LT S e L5 1

Figure 8

Print the drawing:

Access the plot command from “File” pull-down menu, or from the command line or from the
printer icon. On “Plot dialog box™ click on the ““ plot device™ tab; select the printer for your lab.
On plot style table™ tab, select monochrome.ctb. Click on the “plot settings™ tab, and choose the
appropriate scale for you drawing. See the following illustrations:

a. Select your printer
b. Select settings
C. Full preview (Figure 9)
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Ef Piot - Layout4-Layout1

[?)%]
i Learn aboud |
Page sehup Plok style table (pen acsignments)
Name: <Mone > ~ manochrome,cth w |
Pririterfplotter \ Shaded viewport options
Mame; g Properkies
Plotter: HP Lagerlet 4100 Series PS - Windows System Driver - . i 57

:::; 3 CAD lab in Tech buldig %

E— . 0'T1—3

Fiot options
L_JPhot bo fle [ Plot in background
] i : o
Paper size / MNumber of copies o ¥
rr— & T - [Z] Plot with plot stykes
[¥] Plot paperspace bast
Plok area Plot scala [ 1Hide paperspace obiects
Y T [ Plat skamp an
Laryout ot Scales | 101 v [ 5ave changes bo layout
Plok offset (origin set to printabis area) 1 :;ru:hus = Drawing arisntation
w | 0000000 | inch by Mmook ] o ) Portrak .
(&} Landscape | 3=
¥; | 0.000000 inch [ 5cale ineweights

[ Plok upside-down

(o) & s S R e
| | ]

Figure 9

Note:

Select Full Preview: to check your work before sending to the printer.

If your print preview looks correct, right click and select “plot™ from the short-cut menu.
Otherwise exit, check all the print settings and fix the problem.
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